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K.S.R.M. COLLEGE OF ENGINEERING
(UGC-AUTONOMOUS)
' Kadapa,Andhra Pradesh, India— 516 003

Approved by AICTE, New Delhi & Affiliated to INTUA, Ananthapuramu. KSNR

fives on.

An ISO 14001:2004 & 9001: 2015 Certified Institution

Date: 12.10.2022

To

The Principal,
K.S.R.M.College of Engineering,
Kadapa.

Respected Sir,

Sub:KSRMCE - (Civil Engineering Department) Permission to conduct a Certification course on “Revit

Architecture”-Req —Reg.

It is being brought to your kind notice that, With reference to the cited, the Civil Engineering
Department is planning to conduct a Certification course on “Revit Architecture” for V sem B.Tech
students from 17" to 22" October 2022 at 9 AM- 4 PM. In this regard I kindly request you to grant

permission to conduct the certification course.

Thanking you Sir,

Assistant professor,
Dept. of CE

&P /ksrmee.acin - Follow Us: 1 1E) w@ /ksrmeeofficial




K.S.RM. COLLEGE OF ENGINEERING
(UGC-AUTONOMOUS) %
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An ISO 14001:2004 & 9001: 2015 Certified Institution

12-10-2022

Circular

All the V Sem B. Tech students are here by informed that Department of Civil Engineering is going
to conduct a Certification course on “Revit Architecture”from 17* to 22* October 2022 at 9 am to 4pm.
Interested students may register their names with the below link given below on or before 15* October 2022.

. Registration link: https:/forms.gle/02qrGt2Cek2SoL6H9

Resource Person:

Ms.M. Pravallika,
Technical Skill trainer,
APSSDC.

Organizer:
Sri. P.Pavan Kumar, Assistant Professor in CED 1210 Joot¥

Coordinator:
Sri. K.Pramod, Assistant Professor in CED

Co-Coordinator:
Ms. V.Sai Neeraja, Assistant Professor in CED %

Head )
Deaaroment of Civil Engineering
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KSRM

COLLEGE OF ENGINEERING

(UGC-AUTONOMOUS)
Kadapa, Andhra Pradesh, India - 516 005
Approved by AICTE, New Delhi & Affiliated to INTUA, Ananthapuramu

DEPARTMENT OF CIVIL ENGINEERING
under the governance of APSSDC |n assocnatlon with CRI, KSRMCE

One week certlflcatlon course §§s“ 5

flrcthectural Modelmg using
REVIT

Resource person
MISS M Pravalhka
Technlcal skill Trainer
APSSDC Team, Govt., of AP

Codrd;nctor Sri K Pramod, Asst. Professor, Dept. of CE
Co~cordmotor.“M|ssVSQ| Neeraja, Asst. Professor, Dept of CE

Pr..K Chandra Obul Redd! Smt, K Rajeswa

9, CRI Lab

Starts: 17-10-2022
09 00 AM-04.00 PM




10292, 120 M Cadificaton caurse on © Hevit Architacture

Certification course on “ Revit
Architecture ”

For V Sem Civil Engineering Students
*Only Interested Students can fill the form*

* Required

1. Name of the Stude)m (As per SSC) *

2. Roll Number *

3.  Section *
Mark only one oval.

C A
FTT R
/B

(_Jc

4. Phone Number (preferably WhatsApp number)

This content is neither created nor endorsed by Google.

Google Forms

hitps://docs.google.com/forms/d/ivtQgRUmMH3outWi-e3y8TIvES 7ncl.DJjhjX|ix-0QT JM/edit 171
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Department of Civil Engineering

Name of the Event: Certitication course on “Revit Avchitectore”

List of Registrations
SLL.NO. Roll No. Name of the student Section | Branch
1 200Y1A0107 Baslreddy Bharath Simha Roddy A Gk
. 2 200y1 ab‘l 18 Dharmavaram Adilya Sraoram A C.L
3 209y 100147 Mothukuri Rahul A CL
4 200Y 1A0149 Mude Narendra Nalk A CL
Ts 1 219y5a0101 Ajjugottu Rajitha B C.L
6 | 219y5a0102 | Alli Ritwik Kumar B C.k
T7 0 219Y5A0106 Bandaru Munivardhan B C.E
"8 | 219y5a0107 | Bhukya Suresh Nalk B CB
9 1219Y5A0109 | Boliu.Naresh B CE
10 219y6a0110 | B. Roopesh Reddy B “CE
1 219y5a0111 | Challa Naveen B CE
12 219y5a0115 ‘Dampetla Mahesh B cE
13 |219Y5A0116 | Derangula Hemanth Kumar B CE
S 14 219y5a0117 | Enapali Guruteja B CE
15 219y5a0118 Galipothula Samuel B CE
16 | 219y5a0119 G.Rajesh B CE
171 219Y5A0121 | Gogula Avinash = CE
18 219y5a0123 J.Vasu - 0 CE
TTT19 7 21950126 | Kamireddy Jaipal Reddy e C.E
20 | 219Y5A0127 | Kanthuri Hema - CE
21 219y5A0128 | K Sai Kumar Naik R c C.E
22 | 219y5a0131 | KSreeKawya ¢ C.B
23 | 219y5A0132 | Kore Sasirekha C CE




210YHA013A

24 1K Dastagil C B
R 21OYHA0134 Subhnsh Kunchapu [ O
26 210ybn013b Kuruba Lavanya C o9 1)
27 219y56a0136 Kuruva Bangaru Veoresh C K
28 219Y5A0138 Madhatlapalle Vishnu Vardhan C o
20 | 219Y5A0139 Madhavaram Sreedhar C CE
10 | 219y5a0140 | Mala Maddilet c CE
“317 | 34eysa0ia2 | Malishetty Gurulakshmi c CE
5 S TEVERSTAT TR . & CE
33 216Y5A0145 | Mekala Chennakeshavulu c C.E
34 219y5a0146 Mkiran Reddy o C CE
35 219y5a0147 N.Shiva Kishor C CE
36 219Y5A0149 Nare Malleswari Devi C C.E
37 219y5a0161 Palla Yogendra C CE
38 219y5a0152 Pasupuleti Sai Charan C CE
39 219y5a0153 Pathan Rahamathullah Khan C CE
40 219Y5A0154 Patte Jagan Mohan c CE
41 218y5a0155 Pinjari Lalappa C CE
42 219y5a0156 P. Sunanda C CE
43 219Y5A0159 Ratala Chandra Sekhar c C.E
44 219y5a0161 Sandrapalli Venkata Sumalatha C CE
45 219Y5A0163 Shaik Mahaboob Bee C CE
46 219Y5A0165 Shaik Mohammed Zuber C CE
47 219y5a0166 Shaik Nasar C CE
48 219Y5AD167 Shaik Thakkalla Yunus C CE
49 219y5a0169 T. Yesheshwani C CE
50 219Y5A0174 Yerramagari Vignesh Kumar C C.E

/
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K.S.R.M. COLLEGE OF ENGINEERING
(UGC-AUTONOMOUS)
Kadapa,Andhra Pradesh, India-516 003

Approved by AICTE, New Delhi & Affiliated to JNTUA, Ananthapuramu.
An1SO 14001:2004 & 9001: 2015 Certified Institution

Department of Civil Engineering

Certification courseon “Architectural Modeling Using REVIT”

Date Timing | Course Instructor Topic to be covered

17/10/2022 | 9 AM to | Miss. M. Pravalika Introduction to  Building Information
12PM | Technical Skill Trainer, APSSDC Modeling, Revit Architecture Introduction

17/10/2022 | 1PMto | Miss. M. Pravalika User Inter Face, Setting of Units & Working
4PM | Technical Skill Trainer APSSDC with Elevation Views, Placing Walls, Doors

& windows

18/10/2022 | 9 AM to | Miss. M. Pravalika Editing of Walls, Doors & Windows,

12PM | Technical Skill Trainer APSSDC Properties  Palette, Managing Views by
Project Browser

18/10/2022 | 1 PM to | Miss. M. Pravalika Placing of Family Files(Components),
4PM | Technical Skill Trainer APSSDC Modify Tools, Roof & Types of Roofs

19/10/2022 | 9 AM to | Miss. M. Pravalika Floor & Types of Floors, Ceiling
12PM | Technical Skill Trainer APSSDC

19/10/2022 | 1PMto | Miss. M. Pravalika Explain about Curtain wall, Creating Section
4PM | Technical Skill Trainer APSSDC Views

20/10/2022 | 9 AM to | Miss. M. Pravalika . Different Types of Openings, Staircase
12PM | Technical Skill Trainer APSSDC

20/10/2022 | 1PM to | Miss. M. Pravalika Ramp, Railing, Annotations, Model Text
4PM | Technical Skill Trainer APSSDC

21/10/2022 | 9 AM to | Miss. M. Pravalika 3-D Views
12PM | Technical Skill Trainer APSSDC

21/10/2022 | 1 PM to Miss. M. Pravalika . Paint, Creating New Materials
4PM | Technical Skill Trainer APSSDC

22/10/2022 | 9 AM to | Miss. M. Pravalika Massing & Site, Schedules, Page Layout
12PM | Technical Skill Trainer APSSDC

22/10/2022 1 1 PM to | Miss. M. Pravalika Documentation, Project Submission
4PM | Technical Skill Trainer APSSDC

Instructor: W—A\
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K.S.R.M. COLLEGE OF ENGINEERING

(UGC-AUTONOMOUS)
Kadupa, Andhea Pradesh, Indin- 516 003

Approved by ATCTE, New Dellid & Affiliated to INTUA, Ansnthapurama,

lims. a0,

An 18O 14001:2004 & 90012 2015 Certified Institution

Syllabus of Certification Course
Course Name: Architectural Modeling Using REVIT

Table of Contents
L. Introduction to Building Information Modeling
Revit Architecture Introduction
User later Face
Setting of Units & Working with Elevation Views
Placing Walls, Doors & windows
Editing of Walls, Doors & Windows
7. Propertics Palette
. o Type Selector
o Type Parameters
o Instance Parameters
8. Managing Views by Project Browser
9. Placing of Family Files(Components)
10. Modify Tools .
11. Roof & Types of Roofs
12. Floor & Types of Floors
13. Ceiling
14. Explain about Curtain wall
15. Creating Section Views
16. Different Types of Openings
17. Staircase
18. Ramp
19. Railing
20. Annotations
21. Model Text
22. 3-D Views
o Camera Views
o Rendering
o Walkthroughs
. 23. Paint
24. Creating New Materials
25. Massing & Site.
26. Schedules
27. Page Layout
28. Documentation
29. Project Submission
Textbooks:
1. Atefe Makhmalbaf (2022), Building Information Modeling using Revit for Architects and
Engineers, Mavs Open Press.
2. Revit Essentials for Architecture by Paul F. Aubin, hitps://paulaubin.com/books/revit-
essentials-for-architecture/.
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K.S.RM. COLLEGE OF ENGINEERING

(UGC-AUTONOMOUS)

Kadapa, Andhra Pradesh, India - 516 003 " o
Approved by ATCTE, New Delbi & Affilated to INTUA, Ananthapuramu. KSNR
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Department of Civil Engineering
Name of the Event: Certification course on “Revit Architecture”
List of Participants

Sl.No. Name of the Student Nl?n?:)'er Section Branch Signature
1 Mude Narendra Naik 209Y1A0149 : - M (\C}k’)ﬂd\ a (\M-—
2| Ali Ritwik Kumar 2t0v5a0102 | L.E ~Ar ”‘\\A\M\;k
3 Bandaru Munivardhan 219Y5A0106 ® CE K W
N Bhukya Suresh Naik 219v5A0107 i CE 3 g\)“‘"l & {’4}/"&}}/\/\:,
R T 219v5A0109 | B cE (B Nerud K
6 B. Roopesh Reddy 219Y5A0110 i ik 73 %
7| Challa Naveen | 2tovsaorie | B CE | ~ W .
8 | cNikilswar Sai Kumar 2tovsmoriz | © CE | Cwra b
8 Dampetla Mahesh 210¥aRoT1S ° - ;D MO»LLZJ’ZI\ - /
10 Derangula Hemanth Kumar 219Y5A0116 i CE 9 ;E’gﬁfr%
L 219Y5A0117 | B cE |F [; .Y o
12 | 6. Rejesh 219y5A0119 | B CE (‘ W
13 | Goguia Avinash 219Y580121 | ©- CE C’/’ /}\/ V)Qm
14| ) Vasu 219v5A0123 | © CE j _ \& d&\
s Kamireddy Jaipal Reddy 219YGAIN2E © cE K ; :C‘aw N l)\ 4 Mclbi
16 | K Sai Kumar Naik 219ysn0128 | © BB Lo l&w wj/d -
% | o 219v540131{ © CE |5 J}f ’
18 | Kore Sasirekha 219v5p0132 | © CE_ |4 Saqyy (Qk‘;(
19 | K Dastagi 219v580133 |  © CE K. D08 acf ¢
20| subhas 219v580134 | © CE Subhath |
21 | kuruba Lavanya 21950135 | © CE ¥ Lo s

@/ksrmce.ac.in Follow Us: K3 @ w¥ /ksrmceofficial
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22 Madhatlapatie Vishiu Vardban 218YDANTI0 ( Gk (g’g)") ' e

23 Madhavaram Sreedhal 21OYHAOTI0 ‘ or { s ( Hlwr f[ adf ;

20 Mala Maddilot 210Y5A0140 ¢ cE - Ll d (l; 7o i,;

25 Malishetty Gurulakshm 719Y5A0142 (: CE el ‘1’(1 it M

26| e T 210Y5A0143 v CE Me 1eSo.

2T | Mekala Chennakeshavulu 219Y5A0145, C CE B Cheone fo:‘\“’m\/ Y ,I

% | MKranReddy . ..219Y5A0146 - C R VL g" "V,’:}

2| s o | © | o€ | \shive Fishur

30 | Nare Malleswari Devi 218Y5A0149 ¢ CE t\\,\x‘/\,‘»};\\(?ﬂ{(m oy

31 Pasupuleti Sal Charan 219Y5A0152 ¢ CE ? <(30.£ CLQYM

32 | pathan Rahamathu.nah Khan 219Y5A0153 ¢ CE p ) I&Wﬁ)u“&h

33 | patte Jagan Mohan z1ovsotss | © _ CE P ’:)—C\C{W\ \U\O('WV)

3 | p. sunanda 219Y5A0156 | © CE ‘ Su;x ardo .

3 | s sumalatha 219y520161 | © ce |C. & odoabio

36 | shaik Mahaboob Bee 219Y5A0163 © CE (‘fé L@Q& (g(ﬂ ;_,{,»,g 3

37 | Shaik Mohammed Zuber 2tov5A0165 | © CE ,,SZ Z\) L>

38 | Shaik Thekkalla Yunus 210v5h0167 | © CE =) e
@/ksrmce.ac‘in Follow Us: EI®& W /ksrmceofficial




K.S.R.M. COLLEGE OF ENGINEERING

(UGC-AUTONOMOUS)

Kadapa, Andhra P

Approved by AICTE, New Delhi & Affiliated to JNT UA, Ananthapuramu.

radesh, India- 516 003

KSNR

lizes on.

An ISQ 14001:2004 & 9001: 2015 Certified Institution

List of Participants
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L B.Bhavl Sirbo. Reddy| 20001007 7 | B b ddl) +
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List of Participants

Date: 18-10-2022 FN
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L e Rageth 190 (T RIS | gl
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List of Participants Date: 19-10-2022 FN
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Certification Course
On

“Architectural Modeling using REVIT"

V SEM Students

Target Group

Details of Participanfs i 38 Students

Co-Ordinator(s) : Sri. K. Pramod and Miss V Sai Neeraja
Organizing Department ! Civil Engineering
Venue : CRI Lab
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‘One week certification course Skill AP
: APSsocC

ﬂrchitecturaléj‘@baéliiig. using

REVITTFs
~ Resource person
Miss M Pravallika
Technical Skill Trainer
APSSDC Team, Govt., of AP : Q@ criLab

~

Starts: 17-10-2022

Coardinator: Sri K Prameod, Asst. Professor, Dept, of CE

Co-cordinator: Miss V Sai Neera)a, Asst. Professor, Dept. of CE 09.00 AM - 04.00 PM
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Poster of the Event: One Week Certification Course on “Architectural Modeling using
REVIT"
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REPORT
alika, Technical skill Tralner, APSSDC Team

Speaker: Miss. M. Prav

rse on REVIT: REVIT is a BIM tool developed
by Autodesk used for special Designs, Modelling, Visualization, and Documentation.
BIM (Building Information Modelling) is a process to plan, design, construct and
manage a project based on the intelligent prototype developed to advanced
constructions and coordination through the modelling during the project lifecycle. The
present certification course was arranged to enhance the knowledge on Auto Desk
REVIT software to students and give exposure from skilled trainers.

The importance of Certification Cou

The theme of the Certification Course:
The main theme of this certification course is
students and to enhance their knowledge.

to expose the scope of REVIT to

The sequence of the Certification course :

The Certification course was arranges by Department of Civil Engineering for the
B.Tech. V Semester students. The venue was CRI lab, PG Block, KSRMCE. The course
was planned for six days from 17" to 22" October, 2022. Each day Certification course
was organized as two sessions, morning section from 9 AM to 12 PM and Evening
session form 1 PM to 4 PM. All the sessions were hosted by Dr. Amaranatha Reddy
(HOD), Sri. K. Pramod and Miss V Sai Neeraja. A total of 38 students of Department
of Civil Engineering were actively participated in the Certification course.

Welcome speech: :
Sri. K. Pramod (Coordinator of the event), Assistant Professor, Department of Civil

Engineering, KSRMCE expressed a very warm welcome to the HOD, Resource person
and students of the Civil Engineering Department. Then the coordinator introduced
the resource person to the gathering; the brief of their education and professional

experiences was read for the audience.

HOD’s words:
Dr. N. Amaranath Reddy, HOD & Associate Professor of the Dept. of Civil Engineering,

KSRMCE addressed the gathering by welcoming the Resource Person to the event.
HOD remembered the association with Technical skill Trainer Miss M. Pravalika. HOD
shared about the dedication towards work and capabilities of Trainer as his students
and how they evolved to stand in this position by continuous improvement.
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The detailed contents of the Certification Course:

Session 1 (9 AM to 12 PM, 17" October, 2022):

The Trainer explained the six days plan of action of this Certification course as per
given schedule. Session onc majorly concentrated on origin of BIM Tools and its
evolution. It covered the importance of REVIT in various engineering fields such as
planning, designing and 3D Modelling. This session gave brief idea on other design
software's which supports the REVIT user interface. The session also covered the
introduction of other design such as Autodesk Software’s, Sketch Up, 3D max, Staad-
pro, ETABs, etc. and their importance & limitations in specific areas. The trainer
explained about the basics of engineering drawings which are essential before going
to draw any work in REVIT. The trainer explained Introduction to Building
Information Modelling, REVIT Architecture and BIM Tools etc. The trainer explained
types of files in REVIT, uses and applications of REVIT Architecture in now days
whether planning or in 3D Modelling. The session ended with the Explanation
installing software, user interface, BIM dimensions, and types of files in REVIT and
setting of units

Explanation about user mterface, setting of unlts and practxcmg by students
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Session 2(1 PM to 4 PM, 17" October, 2022):

haslc tools in REVIT user interface.

Session 2 started with explanation on

lics was explained by Trainer. The hasic drawing

Selection of Projects and fami

tools in Architecture ment like walls, windows, components, roof, celling, floor,

curtain system, curtain grid, ralling, ramp, stalr case arc etc. The trainer explained

the operation of same tools. The Trainer explained the process of setting lirnits ,
property pallet. General home plan was taken for drawing
1ow to do overall architectural modeling

gning the task

elevation height and
the plan. This session explained about |
with REVIT Architecture. The session was ended by the trainer assi

to students whatever the content delivered on this day.

Practice on user interface, setting of units and other tools in REVIT Architecture

Session '3 (9 AM to 12 PM, 18" October, 2022):

The session startgd with the discussion on previous session. The trainer clarified the
doubts on previous session asked by the students. This session is mainly
concgntrated on drawing of walls in REVIT Architecture. In this session trainer
explained about walls , types of walls, thickness of need to be taken while placing in
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the sense drawing and creating different thickness of walls. In addition Fhat adding of
plastering to the walls was explained. After this the students are practised _whatever
the trainer explained as the taken plan, This session explained about placing Yvalis,
editing walls and practicing is done by students using the above mentioned
commands and shortculs,

Exlanation on Placing walls and Editing walls by the Trainers
Practicing by students on drawing walls, editing walls and applying plastering.

Session 4 (1 AM to 4 PM, 18" October, 2022):

The session started with revision of previous session. The trainer clarified the doubts
on previous session asked by the students. This session is mainly concentrated on
drawing of walls in REVIT Architecture. In this session trainer explained about Doors
and windows,placing doors and windows. Next topic Properties Palette in this type
selector, type parameters, instance Parameters was explained. After this the students
are practised whatever the trainer explained as the taken plan. This session

explained about Doors, windows and palette and practicing is done by students
whatever the trainer was explained
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Session 5 (9 AM to 12 PM, 19" October, 2022):

The session started by explanation of modify tools, placing roof , types of roofs , floor
and type of floors to be taken while drawing the plan as per given planning of
building and creating 3D Model for drawn plan . In addition that modifying of roofs
and floors was explained. After this the students are practised whatever the trainer
explained as the taken plan. This session was completely about modifying the tools,
roofs & floors after that practicing is done by students

IR

- 14.4777248°
Local 03:52:56 P}
L GMT 10:22:56 AM

Practicing by students on Roof & floor editing and applying
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Session 6 (1 AM to 4 PM, 19" October, 2022):

The session started with revision of previous session. The trainer clarified the doubts
on previous session asked by the students. This session is mainly concentrated on
ceiling, how to activate ceiling plan for different floor levels. In this session trainer
explained about curtain walls, creating section views for partition purpose. Next topic
different types of opening in the plan were explained. After this the students are
practised whatever the trainer explained as the taken plan. The today whole session
ended with revision of modify tools, roofs, floors, ceiling, curtain walls , section views
and different types of openings as per the planning of building and practicing is done
by students whatever the trainer was explained.

2 GPS Map

Practicing on activate ceiling plan for different floor levels

Session 7 (9 AM to 12 PM, 20" October, 2022):

The session started by explanation stair case while drawing the plan as per given
planning of building and creating 3D Model for drawn plan. In addition that modifying
of ramp and railing was explained. Placing of stair case in the floor plan as per
runners or by face was explained. Practicing stair case, ramp with slope and railing
for different floor levels with 3D elevation are done as per the schedule. This session
was ended with explanation of stair case, ramp and railing after that practicing is
done by students.
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Modifying of ramp and railing are practiced

Session 8 (1 AM to 4 PM, 20" October, 2022):

The session started with revision of previous session. The trainer clarified the doubts
on previous session asked by the students. This session is mainly concentrated on
Annotations and Model Text. In this session trainer explained about placing of model
text in necessary place and annotations were explained. After this the students are
practised whatever the trainer explained as the taken plan. Today whole session
ended with revision of Stair case, ramp, railing , Annotations and Model Text as per
the planning of building and practicing is done by students whatever the trainer was
explained.
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Revision of Stair case, ramp, railing , Annotations and Model Text

Session 9 (9 AM to 12 PM, 21" October, 2022):
This session concentrated on revision of all the contents which are practiced in

previous session. And also concentrated on new topics which are 3 - D Views in this
subtopics Camera views, Rendering and walkthroughs. As per the request from
student’s side, the vasthu was explained by the trainer in this session. At the end of
the session 3D views are practiced by the studentsfor drawn plan.
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Explanation on Vasthu and its implimentation

Session 10 (1 AM to 4 PM, 21" October, 2022):
The session started with revision of previous session. The trainer clarified the doubts

on previous session asked by the students. This session is mainly concentrated on
Paint, Creating New Materials and massing & site. In this session trainer explained
more about creating new colours, applying different type’s colours as paints.

The session was ending with students practice.
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Creating new colours, applying different type’s colours as paints

Session 11 (9 AM to 12 PM, 22" October, 2022):

This session concentrated on revision of all the contents which are practiced in
previous session. And also concentrated on new topics Schedules, page layout.
Schedule and quantities of different categories for REVIT Architecture is explained in
detail was explained by trainers. At the end of the session different types of drawings
were shared to students which can be drawn using REVIT.
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Explanation on Schedules, page layout

Session 12 (1 AM to 4 PM, 22" October, 2022):

The final session of the certification course summarized and used all the tolls explained in
past five days of this certification course to draw a building plan and 3D Model Elevation.
The Trainer explained how to do documentation and project submission. The session
ended by interacting with students and asking about the past five days experience.
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Students Sharing their Experience

HOD’s words at end of the Event:
At the end of the workshop, Dr. N. Amaranatha Reddy, HOD, Dept. of Civil

Engineering, KSRMCE expressed his regard to the speakers for sharing his knowledge
with the students. HOD whished the trainer to conduct more courses like this in

future.

Vote of thanks:
Sri. K. Pramod (Coordinator of the event) delivered vote of thanks by thanking the

students for their participation, faculty members for their active participation, HOD for
giving the opportunity to conduct such events and organization of KSRMCE for
encouraging conducting such events.
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{Department of Skills Development & Training, Govt. of Andhra Pradesh)

Regdld: 219Y5A0132

Cert.No. REVIT/STP/22-23/095
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APSSDC
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A SO THOT:2004 & 9001: 2018 Cortitied lastitidion Yo
PEPARTAMENT OF CIVIL ENGINEERING
Cortiflcate course Feedback Form
Your teedback is crucial to enstre we meet your edocational necds, We wankd ipprethde it

if you could take a few minutes to share your opinfons witl us so we can serve you hotte

Course Title ‘ : {‘()QU;'( e ‘;u {(‘(, e
Resource Person(s) ¢ ML Praval ko
Date(s) of the course Y (- 2002 (f 22 10 2027
Name of the Student : P, S‘Oj ¢ havan
Roll No. C219ysnolba
. S. ltetﬁﬂl‘)escripii‘én h RATING {Ploasu Tick the relevant)
: No. Low MODERATE HIGH
/ 1 : The content was Clear & Understandable ° » . \((,/
2 | The program was well-paced within the allotted time /,/
3 : Theinstructor was a good communicator - e \/"4"’
4 | The material was pl;esevnvted in an organized manner | N },/
5 | The instructor was knowledgeable about the topic o v \ /
6 | lwould be interested in attending a follow-up, more -
advanced workshop on this same subject/any other ™
7 | Given the topic, was this workshop Too Short | mgm&«éﬁ\ Too Lang
8 . Inyour opinion, was this workshop Introdu'c'tbr;;” Intermpe l:;tu | Advanced
Please Rate the following - Low MODERATE Fil‘g}(
Py S S \;/
b} Acoustics ‘ o & /
. ¢} Meeting space/Venue ’ \/(
d) Handouts o ' : N : WJ
e) The Overall Program A \_//'/ v ’
S | What did you most appreciate/enjoy/think was best -
about the course? Any suggestions for improvement? | | 1 a (a 60& o e .

Please return this form to the instructor or organizer at the end of the course. Thank you.

F : &u‘ ( ,ﬁ\m@ )

Signature of the Student

A/ ksrmce.acin Follow Us: B3 %3 0 Jksimceoflficial




KRS RAM. COLLEGE OF ENGINEERING

(UGC-AUTONOMOUS)

hodngn, Andhien Preadesh, tndin 5t 00X
Approved by ATCEE, Now Delhi & Altilinted to INTUA, Aunanthupursuiu
A SO B 20040 & 900 HHS Certiled Instiution e
PEPAREAIENT OF CIVIL ENGINEERING
Cortiicate course Feedback Torm

Your feedback i cractal to ensure we meet youe educational needs. We would appreciate it
it you could take a Tew mintites to share yoir opinions with us so we can serve you better.

e Akttt

RS P fava 11
O N
s M &(\\end.\c‘\

S0%YVA0 WS

Course Title

Resource Personds)

l 59 - 10 - Q02
ae

Date(s) of the course
Name of the Student

Roll No.

s. Hem Description RATING {Please Tick the relevant)
No, Low MODERATE |  HIGH
1 1 The content was Clear & Ur{dm’slnndabln N
2 | The program was well-paced within the allotted time \/ » ’
3 The ihslruct/{)r was a ggod cv{)hunw\'un‘lé;tt.)rr - s M
4 | The matertal was presented in an organized manner v
5 | The instructor was knbwfedgeable about the topic o e
6 | Iwould be interested in attending a'fbllb\')'\f—'uvbv:wl'ﬁo}é vvvvvvvv
advanced workshoi) on this same subject/any other 7
7 | Given the top'ic, was this workshop Too Short Right Length chn}Long
'8 In youbr (;pinicn, was this workshop Introductory Intermediate Adwamced
Please Rate the following o ow MODERATE HIGH
a} Visuals - -
b} Acoustics
¢} Meeting space/Venue v o
W
d Handouts S — >
e) The Overall Program o
9 | What did you most apﬁi“éé'iéte/enjoy/think was best
: jons for N ood G
about the course? Any suggestions for improvement? f?f'\/l% l‘\g (@] C] 0‘“227’

Please return this form to the instructor or organizer at the end of the course. Thank you.
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Signature of the Student
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Course Title CTRevi = Ak H-((’:ﬁu Y
Resource Person(s) . F M Fm\)qlh“k;a
Date(s) of the course : f:f/lo/?_L 4o 27__&5[ 77
Name of the Student Dk SQS!\LLLCI’)Q
e Roll No. P21 V54013
S. ftem Description RATING (Please Tick the relevant)
No. LOW MODERATE HIGH
1 | The content was Clear & Understandable |
..... A
2 | The program was well-paced within the allotted time ‘/
3 | The instructor was a good communicator
8 =
4 : The material was presented in an organized manner %
5 i The instructor was knowledgeable about the topic .\/\
6 | Iwould be interested in attending a follow-up, more
advanced workshop on this same subject/any other \/
7 | Given the topic, was this workshop Too Short Rigl&ength Too Long
8 | Inyour opinion, was this workshop Introductory Int‘ir/mediate Advanced
Please Rate the following , Low MODERATE HIGH
a} Visuals
) v
b} Acoustics 2
¢} Meeting space/Venue \/
d} Handouts :
) . w7 ‘
e} The Overall Program \/
9 | What did you most appreciate/enjoy/think was best N
about the course? Any suggestions for improvement? H—g(' NO Q“'u?? CJAAHO (\

Please return this form to the instructor or organizer at the end of the course. Thank you.

- Syt fha
Sigigattg'z%vithe Student
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K.S.R.M. COLLEGE OF ENGINEERING (AUTONOMOUS), KADAPA-516003
DEPARTMENT OF CIVIL ENGINEERING

Certificate Course on Architectural Modelling Using Revit

Marks Award List

SNo| Roll Name of the Student ons
1 209Y1A0149 | Mude Narendranaik 18
2 | 219Y5A0102 | Alli Ritwik Kumar 19
3 | 219Y5A0106 | Bandaru Munivardhan 17
4 | 219Y5A0109 | Bollu Naresh 18
5 219Y5A0110 | Bommireddy Roopesh Reddy 19
6 | 219Y5A0111 | Challa Naveen 12

Challagundla Nikileswara Sai
7| 219Y5A0112 | Kumar 15

Chinthakuntla Narendra
8 | 219Y5A0114 | Reddy 15
9 219Y5A0115 | Dampetla Mahesh 17
10 | 219Y5A0116 Derangula Hemanth Kumar 16
11 | 219Y5A0117 | Enapati Guru Teja 13
12 | 219Y5A0117 | Enapati Guru Teja 16
13 | 219Y5A0121 | Gogula Avinash 11
14 | 219Y5A0123 | Jaripiti Vasu 18
15 | 219Y5A0126 Kamireddy Jaipal Reddy 14
16 | 219Y5A0128 | Karamthod Sai Kumar Naik 19
17 | 219Y5A0131 | Koppu Sree Kavya 4
18 | 219Y5A0132 | Kore Sasirekha 18
19 | 219Y5A0133 | Kummari Dastagiri 12
20 | 219Y5A0134 Kunchapu Subhash 17
21 | 219Y5A0135 | Kuruba Lavanya 17

Madhallapalle Vishnu
22 | 219Y5A0138 | Vardhan 16
23 | 219Y5A0139 | Madhavaram Sreedhar 19
24 | 219Y5A0140 | Mala Maddileti is
25 | 219Y5A0142 | Malishetty Guru Lakshmi 16
26 | 219Y5A0143 | Mallu Teja 19




27 | 219Y5A0145 | Mekala Chennakeshavulu 18
28 | 219Y5A0146 | Muthuru Kiran Kumar Reddy 9
29 | 219Y5A0147 | Nallabothula Shiva Kishor 11
30 | 219Y5A0149 | Nare Malleswaridevi 15
31 | 219Y5A0152 | Pasupuleti Sai Charan 18
32 | 219Y5A0153 | Pathan Rahamathullah Khan 18
33 | 219Y5A0154 | Patte Jaganmohan 18
34 | 219Y5A0156 | Poreddy Sunanda 11
Sandrapalli Venkata
35 | 219Y5A0161 | Sumalatha 15
36 | 219Y5A0163 | Shaik Mahaboob Bee 18
37 | 219Y5A0165 | Shaik Mohammed Zuber 19
38 | 219Y5A0167 | Shaik Thakkalla Yunus 15

Coordinator
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Time: 20 Min

DEPARTMENT OF CIVIL ENGINEERING
Certificate Course on Architectural Modelling Using Revit
Assessment Test

(Objective Questions)

Max. Marks: 20

Note: Answer the following Questions and each question carries one mark.

1 | What is Revit primarily used for in the field of architecture?

C) Spreadsheet

D) Building information

[

A)2Ddrafting | B) 3D gaming | 1 " oCS modeling (BIM)
2 | In Revit, what is a "Family"?
A) Group of B) A .
atecs | repesenaton | AUPES(D | DiAparmetie | ()
working together | of a building 9 P
3 | What does "BIM" stand for in the context of architectural software?
. . B) Building C) Beautiful D) Blueprint
:\/I)OEZISIC Imaging Information lllustration Information [&]
Modeling Method Management
4 | What is the purpose of "Levels" in Revit?
A) To define the | B) To set the C) To define
number of floors | building's horizontal planes IEI) )hIi(rjl C?:t;orlotgri g]
in a building structural load | in a building griing
5 | What does the term "Parametric" mean in the context of Revit?
A) A type of Br)o-]c-refs of C) A modeling D) Design elements
architectural process o technique without | that are driven by LA\]'
creating visual ) ; .
style constraints relationships and rules

effects

%\\\\

6 | Which Reuvit tool is used for creating walls, doors, windo

elements?

ws, and other building

A) Sketch tool

B) Paintbrush
tool

C) Line tool

D) Create tool

i)

7 | In Revit, what is a

"View" used for?

A) Changing the | B) Exporting C) Displaying a D) Generating cost [c]
color scheme of | the model to specific portion of | estimates for
the model other software | the model construction

8 | What is the purpose of "Families" in Revit?
Qr)oz;;eo;;resent B) To organize | C) To manage D) To define reusable [D]V
architects project files project schedules | building components

9 | Which feature in Revit helps ensure that changes made in one view are
automatically reflected in all related views?
&) Ve B) Styles C) Filters D) Renderings [ﬁ—‘
Templates y 9

10 | Which Revit tool allows you to create 3D models by extruding 2D shapes?

DASS




A) Extrude tool | B) Convert tool | C) Build tool | D) Extend tool
11 | What is a "Sheet" in Revit used for?
A) A virtual B Atoolfor | 5 Aprined of .
workspace for sketching digital . D) .A _tool for managing [C]
collaborating rough ideas representation of | building components
e a drawing .
12 | What is the primary purpose of using "Tags" in Revit?
A) To |abe_| B) To create C) T epoly D) To generate
elem_ents ina 3%) models fextures to cgnstrgction schedules W
drawing surfaces
13 | What is the purpose of the "Project Browser" in Revit?
A) To browse the | B) To access
internet for project ) TO n}e; nage d D) To connect to cloud Q1
design management Pr DieELIcSHN storage services
P views
inspiration software
14 | What does the "Render" tool in Revit allow you to do?
C) Create
A) Organize B Expant vi)sualizations of D) _Generate cost [ 4]
) - models to e estimates for
! project fles other formats Hie Buikding's construction
‘ appearance
15 | In Revit, what is a "Curtain Wall"?
A) A wall with B) A type of C) A decorative D) An exterior wall [ a
curtains for window architectural system with glass
privacy treatment element panels
16 | How can you adjust the visibility of objects in different views using Revit's
"Visibility Graphics" tool?
B) By C) By controlling
A) By resizing changing the the visibility of D) By creating new [
objects materials of categories and objects
objects elements
17 | Which tool in Revit is used for creating a 3D view of the building's exterior?
A) Elevation tool | B) Section tool | C) Floor Plan tool | D) Perspective tool L4
18 |"What is the purpose of "Worksets" in a collaborative Revit environment?
D) To enable multiple
Q;;l'&create B) Temanage C) To organize users to work on [
ps of praject roject teams different parts of the
project files schedules pro) ; i
project simultaneously
19 | Which Revit feature allows you to adjust the materials and finishes of building
components? [ ﬁ]
G)bl:/::;enal E)amticrenal C) Color Picker D) Texture Tool
20 | How can you add dimensions and annotations to a drawing in Revit?
A) Using the Text | B) Using the C) Using the . . Y
to)ol ° Li)ne toogl D?mens?on tool D) Using the Paint tool
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Time: 20 Min

(Objective Questions)

Max. Marks: 20

Note: Answer the following Questions and each question carries one mark.

1 | What is Revit primarily used for in the field of architecture?

A) 2D drafting

B) 3D gaming

C) Spreadsheet

D) Building information

calculations modeling (BIM)
2 | In Revit, what is a "Family"?
A) Group of B) A .
achiccis | repesenaton | SAMEAIT0 | D) Apmanetrc | (),
working together | of a building 9 P
3 | What does "BIM" stand for in the context of architectural software?
. . B) Building C) Beautiful D) Blueprint
':‘A)Og;s'c Imaging Information Illustration Information [R] \
Modeling Method Management

4 | What is the purpose of "Levels" in Revit?

A) To define the | B) To set the C) To define
number of floors | building's horizontal planes IEI) )h-’[i(r)1 C?:t;orlot;‘; 1
in a building structural load | in a building gnting
5 | What does the term "Parametric" mean in the context of Revit?
A) A type of E) The C) A modeling D) Design elements
: process of : . .
architectural Sreating visusl technique without | that are driven by
style 9 constraints relationships and rules

effects

6 | Which Reuvit tool is used for creating walls, doors, windows, and other building

elements?

A) Sketch tool

B) Paintbrush
tool

C) Line tool

D) Create tool

7 | In Revit, what is a

"View" used for?

A) Changing the
color scheme of
the model

B) Exporting
the model to
other software

C) Displaying a
specific portion of
the model

D) Generating cost
estimates for
construction

8 | What is the purpose of "Families" in

Revit?

A) To represent

B) To organize

C) To manage

D) To define reusable

gigﬁil::cct); project files project schedules | building components

9 | Which feature in Revit helps ensure that changes made in one view are
automatically reflected in all related views? [ t/]]
£3) Vs B) Styles C) Filters D) Renderings 1
Templates

10 | Which Revit tool allows you to create 3D models by extruding 2D shapes?

K|




A) Extrude tool

[ B) Convert tool | C) Build tool

| D) Extend tool

NN

S

N, ™

N

11 | What is a "Sheet" in Revit used for?
. C) A printed or
A) ﬁ\(wr;ual iy S&;‘;&ﬁl for digital D) A tool for managing | [(] \
\cl:vgllasgract?n r s dgas representation of | building components
9 9 a drawing
12 | What is the primary purpose of using "Tags" in Revit?
A) To label C) To apply
. B) To create D) To generate [/-}}
elemgnts nid 3D models lexilyeso construction schedules i
drawing surfaces
13 | What is the purpose of the "Project Browser" in Revit?
A) To browse the | B) To access
internet for project G} To frerage D) To connect to cloud | [(] Y
. project files and )
design management - storage services
s views
inspiration software
14 | What does the "Render" tool in Revit allow you to do?
C) Create
A) Organize B) Export visualizations of D) Qenerate — [C]\]
. : models to o on estimates for
project files other formats the building's construction
appearance
15 | In Revit, what is a "Curtain Wall"?
A) A wall with B) A type of C) A decorative D) An exterior wall [D]
curtains for window architectural system with glass
privacy treatment element panels
16 | How can you adjust the visibility of objects in different views using Revit's
"Visibility Graphics" tool?
N B) By . C) BY c;o_ntrolling ' [ CLK
A) By resizing changing the the visibility of D) By creating new
objects materials of categories and objects
objects elements
17 | Which tool in Revit is used for creating a 3D view of the building's exterior? [
A) Elevation tool | B) Section tool | C) Floor Plan tool | D) Perspective tool M
18 | What is the purpose of "Worksets" in a collaborative Revit environment?
D) To enable multiple
A Tocreate £l 1o ieEaage C) To organize users to work on [\
backups of project . .
. : project teams different parts of the
project files schedules : ;
project simultaneously
19 | Which Revit feature allows you to adjust the materials and finishes of building
components? [8'\
A) Material B) Material .
Library Pairiter C) Color Picker D) Texture Tool
20 | How can you add dimensions and annotations to a drawing in Revit?

A) Using the Text

B) Using the

tool

Line tool

C) Using the
Dimension tool

D) Using the Paint tool

[C1\]
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Max. Marks: 20

Note: Answer the following Questions and each question carries one mark.

1| What is Revit primarily used for in the field of architecture?

A) 2D drafting

B) 3D gaming

C) Spreadsheet

D) Building information

[P

calculations modeling (BIM)
2 | In Revit, what is a "Family"?
A) Group of B) A .
architects representation \C/:I)S uAa}iyzz ?igrf‘ <D E&igigariyetnie t [[;P
working together | of a building g componen
3 | What does "BIM" stand for in the context of architectural software?
. . B) Building C) Beautiful D) Blueprint
/:\A)CJEZISIC Imaging Information lllustration Information [{3
Modeling Method Management

4 | What is the purpose of "Levels" in R

evit?

A) To define the | B) To set the C) To define
number of floors | building's horizontal planes :? )h-[icr)1 C?:gcfotgri C]
in a building structural load | in a building ghting

5 | What does the term "Parametric" mean in the context of Revit?
A) A type of i) The f C) A modeling D) Design elements [D
architectural ProgEas o technique without | that are driven by
style erEaing ustial constraints relationships and rules

effects

6 | Which Revit tool is used for creating walls, doors, windows, and other building

elements?

A) Sketch tool

B) Paintbrush
tool

C) Line tool

D) Create tool

7 | In Revit, what is a

"View" used for?

A) Changing the
color scheme of
the model

B) Exporting
the model to
other software

C) Displaying a
specific portion of
the model

D) Generating cost
estimates for
construction

8 | What is the purpose of "Families" in

Revit?

A) To represent
groups of
architects

B) To organize
project files

C) To manage
project schedules

D) To define reusable
building components

9 | Which feature in Revit helps ensure
automatically reflected in all related views?

that changes made in one view are

A) View

B) Styles

Templates

C) Filters

D) Renderings

10

Which Revit tool allows you to create 3D models by extruding 2D shapes?

N

N\

NN NN N N D




A) Extrude tool

[ B) Convert tool

[ C) Build tool

| D) Extend tool

A) Using the Text
tool

B) Using the
Line tool

C) Using the
Dimension tool

D) Using the Paint tool

11 | What is a "Sheet" in Revit used for?
. C) A printed or
i /T(vur;ual for sBlZ eﬁ\ctr?iﬁl ier digital D) A tool for managing [Cl
\c,:vc?llrazgra?t?n rouah i dg representation of | building components
g Lgh-dess a drawing
12 | What is the primary purpose of usin "Tags" in Revit?
g)el-woelnatgi o B) To create tCe) xtTJC:easp’g y D) To generate [A]
drawi 3D models o construction schedules
rawing surfaces
13 | What is the purpose of the "Project Browser" in Revit?
A) To browse the | B) To access
internet for project C) TO ,:TCT nage d D) To connect to cloud [Cl
design management Rrojee lies an storage services
i views
inspiration software
14 | What does the "Render" tool in Revit allow you to do?
: C) Create
A) Organize B) Ex;l:)ort visualizations of D) _Genera;ce s [O
project files IIEECISiD the building's estimates Tor
other formats construction
appearance
15 | In Revit, what is a "Curtain Wall"?
A) A wall with B) A type of C) A decorative D) An exterior wall tD
curtains for window architectural system with glass
privacy treatment element panels
16 | How can you adjust the visibility of objects in different views using Revit's
"Visibility Graphics" tool?
B) By C) By controlling [%
‘A) By resizing changing the the visibility of D) By creating new
objects materials of categories and objects
objects elements
17 | Which tool in Revit is used for creating a 3D view of the building's exterior? A
A) Elevation tool | B) Section tool | C) Floor Plan tool | D) Perspective tool [
18 | What is the purpose of "Worksets" in a collaborative Revit environment?
D) To enable multiple
'g‘) e = B) TO MERag= C) To organize users to work on L/}}
ACKUES 07 projeet project teams different parts of the
project files schedules ; |
project simultaneously
19 | Which Revit feature allows you to adjust the materials and finishes of building
components? IB
f\.) Material B) Material C) Color Picker | D) Texture Tool
ibrary Painter
20 | How can you add dimensions and annotations to a drawing in Revit?

]
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K.S.R.M. COLLEGE OF ENGINEERING (AUTONOMOUS), KADAPA-516003
DEPARTMENT OF CIVIL ENGINEERING
Certificate Course on Architectural Modelling Using Revit

Assessment Test
Name of the Student: 13 - Mgp: veord hon Reg. Number: 2 445 Ao o
Time: 20 Min (Objective Questions) Max. Marks: 20

Note: Answer the following Questions and each question carries one mark.

1 | What is Revit primarily used for in the field of architecture? r
A)2D drafting | B) 3D gaming | C) SPreadsheet | D) Bulding information | LfJ |
calculations modeling (BIM) 1
® 2 | In Revit, what is a "Family"? e
e A) Group of B) A . Jﬂ{
architects representation C.) A lf.yp?. of 3D E )‘G.parametrlc t ]
_working together | of a building visualization WIS RERROa
'3 | What does "BIM" stand for in the context of architectural software? /
. : B) Building C) Beautiful D) Blueprint
I\A/I)OE:ISIC Imaging Information lllustration Information y/
Modeling Method Management
4 | What is the purpose of "Levels" in Revit? o
A) To definethe | B) To set the C) To define
number of floors | building's horizontal planes IIID )hl-i(ri C?:gorlc;[gneq /[’é]/
in a building structural load | in a building ghting
5 | What does the term "Parametric" mean in the context of Revit? |
B) The : :
A) A type of f C) A modeling D) Design elements /0]/
architectural proc?ss o I technique without | that are driven by )
style creating visua constraints relationships and rules
effects
6 | Which Revit tool is used for creating walls, doors, windows, and other building >
O elements? [Di
A) Sketch tool golralntbrush C) Line tool D) Create tool
7| In Revit, what is a "View" used for? L
A) Changing the | B) Exporting C) Displaying a D) Generating cost /{4
color scheme of | the model to specific portion of | estimates for
the model other software | the model construction
8 | What is the purpose of "Families" in Revit?
gr)ozgsreoaresent B) To or_ganize C) To manage D).Tg define reusable /[Dﬂ )
architacts project files project schedules | building components A
9 | Which feature in Revit helps ensure that changes made in one view are Tl
automatically reflected in all related views? M
A) View B) Styles C) Fillters D) Renderings
Templates
10 | Which Revit tool allows you to create 3D models by extruding 2D shapes? /m




A) Extrude tool | B) Convert tool | C) Build tool | D) Extend tool
11 | What is a "Sheet" in Revit used for?

C) A printed or

P AU B) A tool for digital D) A tool for managing | [ X
\év;‘rlgzg?acteiznfor fgstcr:‘h_l(r;g representation of | building components B] )
9 gh ldeas a drawing
12 | What is the primary purpose of usin "Tags" in Revit? /
A) To label C) To apply

D) To generate

) construction schedules
drawing surfaces )

13 | What is the purpose of the "Project Browser" in Revit?

el
A) To browse the | B) To access
C) To manage D) To connect to cloud %

internet for project project files and

. B) To create
elementsin a 3D models textures to

design management e storage services /
inspiration software
14 | What does the "Render" tool in Revit allow you to do?
C) Create
A) Organize E) Expart visualizations of D) Qenerate east [g]
gl A models to g estimates for )\
projest files other formats the building’s construction
appearance
15 | In Revit, what is a "Curtain Wall"?
A) A wall with B) A type of C) A decorative D) An exterior wall [l
curtains for window architectural system with glass 7K
| privacy treatment element panels

16 | How can you adjust the visibility of objects in different views using Revit's
"Visibility Graphics" tool?

B) By C) By controlling S
A) By resizing changing the the visibility of D) By creating new /[QY
objects materials of categories and objects /]
objects elements
17 | Which tool in Revit is used for creating a 3D view of the building's exterior? /
A) Elevation tool | B) Section tool | C) Floor Plan tool | D) Perspective tool [A;/
18 [ What is the purpose of "Worksets" in a collaborative Revit environment? 4
D) To enable multiple
ﬁ;;l’k%create B) TO manage C) To organize users to work on [D] L—
psof projet roject teams different parts of the /
| project files schedules pEo) : P
project simultaneously

19 | Which Revit feature allows you to adjust the materials and finishes of building

components? [ 7
A) Material B) Material . /B/
Library Painter C) Color Picker D) Texture Tool
20 | How can you add dimensions and annotations to a drawing in Revit?
A) Using the Text | B) Using the C) Using the . .
tool Line tool Dimension tool D) Using the Paint tool
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DEPARTMENT OF CIVIL ENGINEERING
Certificate Course on Architectural Modelling Using Revit
Assessment Test

(Objective Questions)

Reg. Number: _ 2 19Y sA0]0 2

Max. Marks: 20

Note: Answer the following Questions and each question carries one mark.

1 [ What is Revit primarily used for in the field of architecture?

C) Spreadsheet

D) Building information

A) 2D drafting B) 3D gaming calculations modeling (BIM)
2 | In Revit, what is a "Family"?
A) Group of B) A .
awhiccs | repesetaton | AP | D) sparametie | 113
working together | of a building 9 B
3 | What does "BIM" stand for in the context of architectural software?
. . B) Building C) Beautiful D) Blueprint
':‘,I)ngls'c Imaging Information lllustration Information [-@/
Modeling Method Management

4 | What is the purpose of "Levels" in Revit?

NN SN

A) Todefinethe | B) Tosetthe | C) To define g
number of floors | building's horizontal planes IIID )hl-icr)l C?:gorlggri [l
in a building structural load | in a building gnting

5 | What does the term "Parametric" mean in the context of Revit?
A) A type of Er)o-crzzzs o C) A modeling D) Design elements m
architectural areating visual technique without | that are driven by 4
style g constraints relationships and rules

effects

6 | Which Revit tool is used for creating walls, doors, windows, and other building

elements?

A) Sketch tool

B) Paintbrush
tool

C) Line tool

D) Create tool

7 | In Revit, what is a

"View" used for?

A) Changing the
color scheme of
the model

B) Exporting
the model to
other software

C) Displaying a
specific portion of
the model

D) Generating cost
estimates for
construction

8 |['What is the purpose of "Families" in

Revit?

A) To represent
groups of
architects

B) To organize
project files

C) To manage
project schedules

D) To define reusable
building components

9 | Which feature in Revit helps ensure
automatically reflected in all related

that changes made
views?

in one view are

A) View
Templates

B) Styles

C) Filters

D) Renderings

VAN NS

10

Which Revit tool allows you to create 3D models by extruding 2D shapes?




A) Extrude tool

[ B) Convert tool | C) Build tool

| D) Extend tool

11 | What is a "Sheet" in Revit used for?
. C) A printed or /
C‘V) 'A“(V'rttézl for S& Qg&ﬁ‘ for digital D) A tool for managing | [
cc?llrats)g?atin — dgas representation of | building components
9 g a drawing
12 | What is the primary purpose of using "Tags" in Revit?
A) Ta Iabgl B) To create C) To apply D) To generate /
glrzrvr;;ngts na 3D models tsix:fgl;?essto construction schedules JAJ
13 | What is the purpose of the "Project Browser" in Revit? /
A) To browse the | B) To access
in)ternet for p20ject G '_I'o r?Tnage q D) To connect to cloud | (] 1
design management B Oeet fles e storage services
B views
inspiration software
14 | What does the "Render" tool in Revit allow you to do? /
C) Create
A) Organize ?OE);?SO{:) visualizations of Egtﬁqear;:rsaftsrcost El
project files other formats the building's construction
appearance
15 | In Revit, what is a "Curtain Wall"? /
A) A wall with B) A type of C) A decorative D) An exterior wall )
curtains for window architectural system with glass @
privacy treatment element panels
16 | How can you adjust the visibility of objects in different views using Revit's
"isibility Graphics" tool? /
B) By C) By controlling (14
A) By resizing changing the the visibility of D) By creating new a
objects materials of categories and objects
objects elements
17 | Which tool in Revit is used for creating a 3D view of the building's exterior? /
A) Elevation tool | B) Section tool | C) Floor Plan tool | D) Perspective tool ~AE
18 | What is the purpose of "Worksets" in a collaborative Revit environment? .
D) To enable multiple
'g‘) Tg-greale &) To manage C) To organize users to work on Jﬂ) /
SKUS of project roject teams different parts of the
project files schedules R - P
project simultaneously
19 | Which Revit feature allows you to adjust the materials and finishes of building
components? ) /
; . )
ﬁ)b':’;f;e”a' B) Material | ¢) Golor Picker | D) Texture Tool
20 | How can you add dimensions and annotations to a drawing in Revit?
A) Using the Text | B) Using the C) Using the . g [}
tool Line too% D?mensigon tool D) Using the Paint tool
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= In the “Open” dialog box, browse to the Chapter02 folder.
= Double-click Chapter02.rvt to open the project. You can also select it and then click the Open button.

The project will open in displaying a sheet with an overhead 3D view.
The dataset for this chapter provided courtesy of Mark Schmieding, FAIA.

GETTING ACQUAINTED WITH THE PROJECT

For this tutorial, we will explore a series of sheet views included in the project. A sheet view is a special kind of view
that emulates a sheet of paper from which drawing sets can be printed to output devices. Sheet views typically include
a title block which contains project and drawing information. Revit remembers the last view that was open when
the project was saved. In this case, it is a three-dimensional aerial view of this small one-floor project for a youth
center. It includes offices, exam and counseling rooms, a multipurpose room, and media rooms. Let’s take a closer
look (see Figure 2.10).

Phlebotomy /
General ——___
Purpose
Room
Bathroom —
R Media
Area
{
|
1
Offices i
|
| [Ne. Description [ Date i : ]|z
| 5 PAUL F. AUBIN |[Social Services Board —— | Function Diagram
CONSULTING SERVICES Project number 20210201 3|
Dele 71172020 00 2l
www.paulaubin.com || Youth Center by VS — g
Revit Essentials for Architecture by Paul F. Aubin Copynght {C) 2020 Paul F. Aubin Gl :

FIGURE2.10 ke Youth Center dataset shown from the “Function Diagram” sheet

VIEW NAVIGATION

You can use the wheel on your mouse to zoom in and out in any view. You can hold the wheel in and drag to pan the
screen. If you are working on a laptop and don’t have a wheel mouse, you can use the commands on the Navigation
Bar (located by default in the upper right corner of the view window) to navigate in any view. Depending on the
kind of view active on screen, you will have access to differing tools on the Navigation Bar (see Figure 2.11). Among
these are the Steering Wheel, the Zoom pop-up, and the ViewCube. The ViewCube and 3D steering wheel appear
in 3D views.

* Revit Essentials for Architecture ¢
Copyright (c) 2020 Paul F. Aubin, All rights reserved
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In 30 views. the T It 30 views,
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20 stzering wieel
i aeaitabie

FIGURE 2.11 Zoom the sheet 1o Sheet Size and pan around to see it as it will print. Pan with the wheel mouse or the steering wheel

NOTE: Revit includes 3D connexion device support. If you have one of these devices connected to your -
computer, you can use it to navigate in 2D and 3D views. Additional icons will appear on the Navigation
Bar indicating that the device is detected and available for use in Revit. Learn more at: 3dconnexion.com.

The zoom pop-up offers many ways to zoom the current window. Most of these commands will be available in all
kinds of views, like: Zoom To Fit (which fits the screen to the extent of the model) and: Zoom In Region (which
allows you to drag a rectangular region on screen to magnify that area). We also have the handy: Zoom Sheet Size
available. This command zooms a view to a size comparable on screen to the actual size it will appear when printed.
Since Revit displays line weights and other graphics accurately on screen, this can give you a good preview of how
the sheet will look when printed (with today’s high resolution monitors, this is a good approximation). Each of the
z0om commands has a command shortcut that you can execute via the keyboard. These shortcuts are two characters
and you simply type both characters in succession to execute the appropriate command. For example, to issue Zoom
to Fit, you can simply type: ZE. All of the zoom shortcuts are shown in Table 2.D.

TABLE2.D Keyboard shortcuss for Zoom commands

Zoom Command Keyboard Shortcut
Zoom in Region ZR
Zoom Out (2x) 70
Zoom to Fit ZF
Zoom All to Fit ZA
Zoom Sheet Size 7S
Previous Pan/Zoom yAY

1. From the Zoom pop-up on the Navigation Bar, choose: Zoom in Region.

You can also type ZR to issue this command. if Zoom in Region is already selected (a checkmark
appears next to it) then simply click the zoom icon to execute the command.

= Drag a rectangular region around the upper left corner of the drawing.
2. Hold in the wheel on the mouse and drag around to pan the model.

If you prefer, you can use the scroll bars instead.

The image you see on screen is the view named: Large Overview. It is in the 3D Views branch of the Project Browser.

It has been added to the current sheer and displays in a “Viewport™.

3. Zoom back out. The easiest way is to choose: Zoom to Fit from the Zoom pop-up menu (shortcut: ZFY.
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The Steering Wheel offers an alternative to wheel mouse navigation with such commands as dynamic zoom and
pan. Click the Steering Wheel icon to make it appear. In this case, since we have a sheet active, only the two-di-

mensional commands will appear. (This is true even though a 3D view is placed on the sheet; the sheet itselfis still
two-dimensional).

4. Click on the Steering Wheel icon (the tool tip will read “2D Wheel”).

Each function works the same way. Place your mouse on the area of the wheel for the function you want. It will
highlight as your cursor passes over it. You are also simultaneously moving the wheel around the screen with the
movement of your mouse, so it takes some practice. Click and drag with the mouse to begin the function. For exam-
ple, if you wish to zoom, move the wheel to the area of the screen that you wish to center your zoom on, move the
pointer over the Zoom part of the wheel, click and hold down the mouse and begin to drag. Dragging up zooms in,
dragging down zooms out. Varying the speed of your dragging varies the speed of the zooming, Release the mouse
button to stop zooming and make the wheel reappear to change functions. Pan works the same way except that
panning occurs in the direction that you drag (see Figure 2.12).
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FIGURE 212 Steering wheels offer many view navigation Junctions. Drag on the part of the wheel labeled for the funcrion you want to use

As you perform several zooms and pans, they are stored in memory. You can use the Rewind function to back up
through previous zooms and pans in a visual way. Move your mouse pointer over the Rewind funcrion, click and
hold down. A ribbon of thumbnail previews will appear, each representing a previous zoom or pan. Drag to the left
to highlight previous zooms and pans, drag back to the right to move forward. Release the mouse to stop rewinding

or forwarding. When you are done with the wheel, click the small dose box (*X7) in the upper right corner of the
wheel or press esc.

5. When finished experimenting with Steering Wheel, close it to continue.

UNDERSTANDING SCREEN TOOL TIPS

You can get feedback on the elements onscreen as your mouse passes over them.

1. Zoom to Fit. (In addition to the methods already covered, you can right-
click to access common zoom commands like Zoom to Fit.

= Move your mouse pointer into the middle of the screen and pause
it there—pause over the drawing, (not a text note).

Do not click the mouse.

Notice how a rectangular border highlights around the 3D image. As you pause the mouse, an onscreen tool tip
should appear as well. In this case, this tip will read: V iewports : Viewport : No Title (see Figure 2.13).

NOTE: The same information appears in the status line at the bottom left corner of the Revit interface.
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The tool tip conveys three bits of information about the element highlighted—its Category : Family name: Type

name. So, in this case, the element category is “Viewports,” the family is “Viewport” and the type is “No Title.”

2. Now hover the pointer over a piece of text but do not click.

This is called “Pre-highlighting.” The tool tip for a piece of text will read—Text Notes : Text : 3D Notes. Here, Text
Notes is the category, Text is the family and 3D Notes is the type. Since the 3D view is a viewport containing one
of our project views, you do not sce the elements within the model pre-highlighting. However, you can choose to
“Activate” the viewport and that will give you access to the building model elements shown within the view. Editing

them from a viewport is no different than opening the view from the Project Browser and editing them there; the

results are the same view either way. Let’s take a look.

3. Pre-highlight the viewport, and then click to select it this time.

= On the Modify | Viewports ribbon, click the Activate View button (you can double-click inside the viewport as well).
Notice that the sheet title block and the text labels have grayed out. While they are still visible, this graying effect
indicates that they are currently inactive and that you are now working inside the viewport.

4. Move the mouse around the model.

Notice that the elements within the model now pre-highlight.
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FIGURE 2.14 Once the viewport is activated, you can pre-highlight the elements in the model

We will not actually edit any model objects in this view but do take notice of the tool tips. The interior partitions,
for example, display as: Walls : Basic Wall : Generic - 6". The category is: Walls, the family is: Basic Wall and the
type is: Generic - 6" (see Figure 2.14).

Feel free to select objects if you like, but don't edit anything. If you accidentally move or change an element, click
the undo icon on the Quick Access Toolbar (QAT) at the top left corner of the Revit interface. Or press CTRL + .

You may also notice that with the three-dimensional view now active, in addition to the Navigation Bar, the ViewCube
is also displayed. The ViewCube is a 3D navigational tool available in all Autodesk products. Clicking on any of the
labeled sides of the cube will orient the view to that direction such as top, front, or right. There are also several active
regions between faces that will orient the view at an angle between the two adjacent faces. For example, click the
edge berween front and right to orient the view to the southeast. Click the corner between three faces to orient the
view to an axonometric orientation. You can also click and drag any edge of the cube to orbit the model in real-time.
Feel free to experiment with the ViewCube to get the hang of it (see Figure 2.15).
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FIGURE 2.15 T7hree-dimensional views show the ViewCube. Use it to quickly reorient the 3D view

In addition to the ViewCube, the Steering Wheel has more options in a three-dimensional view. You can orbit the
view, change the center of rotation, move the vantage point up and down, and walk and look around the model.
Consult the online help for more information on these options and the many ways you can customize the Steering
Wheels to suit your preferences.

5. Feel free to experiment with the ViewCube and the 3D Steering Wheel in this 3D view.

= Before continuing, reset the view back to its original state.
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To do this, click the Steering Wheel, and then use the Rewind tool or right-click on
the Steering Wheel and choose: Undo View Orientation Changes.

6. When you are done exploring in the model, right-click in the Viewport again and choose: Deactivate View.

This returns you to the sheet and the elements in the view are no longer selectable.

VIEWS AND DETAILING

Earlier we discussed how model and annotation elements were handled in distinct ways. Continuing in this file, let’s

explore the difference between model and view-specific/annotation elements a bit furcher.

1. On the Project Browser, beneath the Views (all) branch, double-click to open the: _Main Floor plan view.

This is the basic floor plan view for this project.

2. On the Project Browser, double-click to open the _Room Callouts plan view.
This plan is very similar to the _Main Floor view except that it also includes callouts around the General Purpose
Room on the left and some elevation and section markers. A sheet has been provided showing each of these views.

3. On the Project Browser, beneath the Sheets (all) branch, double-click to open the 05 — Room Callout sheet view.

Notice how the only visual difference here is that the plan appears on a title block sheet in this view.

4, On the Project Browser, double-click to open the 02 — Floor Plan sheet view.
This is the sheet presentation of the _Main Floor plan view. In other words, this sheet composes the _Main Floor plan
view on a title block for printing. You can easily see which views appear on a sheet in the Project Browser.

5. On the Project Browser, beneath the Sheets branch, expand the tree (click
the small plus (+) sign) beneath the 01 — Shaded Plan sheet.

= Double-click the sheet to open it (see Figure 2.16).
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FIGURE 2.16 Expand the sheet entries in the Project Browser to see the views they contain
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This provides an easy way to see which views are inserted on sheets. Another useful tool {noted above) gives us a way
to see which views have not yet been placed on sheets.
6. On the Project Browser, scroll to the top and select the Views (aif) branch.

= On the Properties palette, from the Type Selector {drop down list at the
top), choose: not on sheets (similar to Figure 2.9 above).

Notice that the list of views on the Project Browser now shows only those views that are not yet assigned to a sheet.
In this project, there are only a couple views not placed on sheets. Expand each sub-group to see.

7. Make sure that “Views (not on sheets)” is selected, and then on the Properties palette, change back to: all.

This sets the default browser organization back to showing all views regardless of their placement on sheets.

8. On the Project Browser, double-click to return to the _Main Floor plan view. Or just click its tab if it is still open,

Suppose that we needed to create another floor plan that was similar to this one, but that was to convey a different
type of information on the printed sheet or that we were planning to use simply as a convenient place in which to
edit the model with no intention of adding it to a sheet. To achieve either goal, we simply duplicate an existi ng view.

9, On the Project Browser, right-click the _Main Floor plan view and choose: Dupiicate View > Duplicate.

A new floor plan view named: _Main Floor Copy 1 will appear and become active. Notice that none of the room
labels or dimensions were copied in this operation. This might be useful if you were creating a “working” view. A
“working” view is intended as a view in which you manipulate the model anly and do not plan to add to a sheet for
printing. Bear in mind that nothing prevents the working view from being used on a sheet; rather it is si mply not

intended for that purpose by our project team. If we want to duplicate the view, including the tags and dimensions,
we choose a different command.

10.  Onthe Project Browser, right-click the original _Main Floor plan view again
and choose: Duplicate View > Duplicate with Detailing.

NOTE: “Duplicate with Detailing” is short for “Duplicate with view-specific detailing elements and
annotation elements.” Remember that the “detailing” is being copied, while the model elements are simply

being viewed.

A new floor plan view named: _Main Floor Copy 2 will appear and become active. Notice that this copy includes

copies of the room tags and dimensions.
= Right-click _Main Floor Copy 2 and choose: Rename.
= Type: Area Diagram and then press enter,
11.  With the cTre key held down, select each of the dimensions in the view (five total).
> Press the peceve Key.
We do not need dimensions for the new view we are creating. However, there is no way to duplicate only the room

tags and not the dimensions, so simply deleting them achieves the desired result. But the critical thing to remeniber

here is that the dimensions still exist in the original _Main Floor view. We only deleted the copied oues here.
12.  Onthe Annotate tab of the ribbon, on the Color Fill panel, click the Color Fill Legend tool.
A small square with a tag will appear attached to the cursor.

= Click a point above the plan to place the Color Scheme Legend.
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= In the dialog that appears, for Space Type, choose: Rooms and then click OK.

As you can see, the Scheme 1 color scheme color codes cach room based on its name. The legend itself is currently

overlapping the plan. To make it fit better, we can resize and/or move it.

13.  Click on the Color Fill Legend and then drag the small round Control at the
bottom up to make the legend two columns (see Figure 2.17).
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FIGURE 2.17 Create a Legend for the new shaded plan and then resize the legend

14.  On the Project Browser, double-click to open the 04 — Area Diagram sheet view.

A sheet appears on screen, which does not yet have a drawing on it. Let’s add our new shaded plan to this sheet.
= On the Project Browser, right-click the 04 — Area Diagram sheet and choose: Add View.

= From the “Views” dialog, choose: Floor Plan: Area Diagram view and then click the Add View to Sheet button.

= Click to place the view on the sheet. ‘
Notice that the view is a little too big for the sheet. We can adjust the scale of the view and it will update automat-
ically on the sheet.

15.  On the Project Browser, select the: Area Diagram view.

= On the Properties palette, from the View Scale list, choose: 1/8"=1'-0" (see Figure 2.18).
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You should see the change on the sheet immediately. If necessary, you can move
the viewport around to make a nicer composition on the sheet.

You should also look at the _Furniture Plan foor plan view and the 03- Layout Plan sheet next. In this view and
sheet, you will notice that the plan is displayed with furniture. Therefore, creating plans with and withourt detailing
(text and other annotation) is not the only way to vary the specifics of what we see. We can also control the visibility
of each type of element in any Revit view. The visibility settings are a parameter of the view itself. This is how we
can choose to display the furniture in the _Furniture Plan view and not display it in the _Main Floor view. On the
View tab of the ribbon, on the Graphics panel, you can choose the Visibility/ Graphics tool (VG). This will display
a dialog listing all element categories and enables you to turn on and off these categories within the current view.
While we will discuss the specifics of this process in later chapters, the important point for this exercise is that this
sort of control is possible and extremely useful. If you wish to explore the “Visibility/Graphics Overrides” dialog,
please feel free to do so. Simply undo your changes before continuing with the lesson.

EDIT IN ANY VIEW

Perhaps the most powerful feature of Revit is the ability to edit in any view and see the results instantly in all views.

1. On the Project Browser, double-click to open the 06 — General Purpose Room sheet
view. Then on the View tab, on the Windows panel, click the Close Inactive button.

This closes all the other tabs. As you can see from this simple exercise, it is easy to end up with many open view tabs.
Using this tool every so often helps keep a tidy workspace and preserves computer resources. The 06 sheer we have

open shows a plan and four interior elevations. All these views show the General Purpose Room.
2. Select the plan view on the left, right-click and choose: Activate View (or double-click on the viewport).
3. On the Architecture tab of the ribbon click the Window tool.

= Click a point on the exterior wall on the left to add a new window (see Figure 2.19).
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FIGURE 2.19 Add 2 window and it appears in all appropriate views automatically
Notice that the window appears immediately in the north elevation (detail 5 on the sheet).

4, Right-click in the plan view again and choose: Deactivate View.

EXPLORE A DETAIL VIEW

As we have noted above, a detail view is a little different than the other views. Typically it will include a live view of
the model—usually a callout of some part of a section or plan—and various types of annotation and other graphical

embellishments drawn on top. One such detail view has been included in this sample daraset.
1. On the Project Browser, expand (click the plus [+] sign) the 07 — Building Details sheet view.
Beneath this sheet is a listing of three views that are already placed on the sheet.
= Beneath the 07 — Building Details sheet view entry, double-click to open the: Section : Section Detail view.

2. Pre-highlight some of the elements in this view (see Figure 2.20).
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FIGURE 2.20 Explore a detail view—Note the combination of detail and model elements

Notice that the derail view contains both model elements (which would appear in all views) and detail elements
(which appear only in this view). Even though the detail elements represent items like concrete blocks, brick, flashing,
and bond beams, the level of detail required in a construction derail is much higher than that required in nearly any
other view. Therefore, these types of items are typically drawn as detail elements on top of the model view geometry
to keep overhead low and reduce the amount of rime and effort required to build your overall model. An even easier

way to see this is to change the way the model displays on the Properties palette.
3. Make sure that nothing is selected (press esc). On the Properties palette, next to Display Model, choose: Halftone.
Notice how the elements that are parts of the 3D model now display grayed out.

= Set it to: Do not display next.
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1. Zoom in on the middle of the right vertical exterior wall. This is where our fireplace will go.
2. Onthe Architecture tab, click the drop down button on the Component tool and choose: Model In-Place.

= In the “Family Category and Parameters” dialog, choose: Generic Models, and then click OK (see Figure 4.59).
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FIGURE4.58 Create an in- p]acc Jamily and choose its category

NOTE: Modeling in-place is not avaﬂable in Revu IT Ifyou are using LT, you can create an  actual component
family and load it instead. From the File menu, choose: New > Family. Then choose the Generic Model.1f
[Metric GezmMaa‘eérﬁ‘ template from the list and then dlick Open. Add the reference planes as noted below,
but instead of measuring them from the exmtmg walls, place them so that the reccangular space they describe
is centered on the two reference plan&s already in the template. Build the rest of the family following the same
steps indicated. Save the file when ﬁmshed as: Fireplace and then load it into the project and place it where
indicated in the ﬁgures bclow. A versnon of this ﬁamﬂy is provided in the Cbapmﬂé\@amp[m' folder called:
Fireplace ﬁ)r LT)}‘&

The family category list is a fixed list built into the software. When you create a tamily, you must assign it one of these

categories. The family you create will inherit the characteristics of the category to which it is assigned. In general,
when choosing a category, try to select the one that most closely matches the actual object that you are creating, The
Construction Specifications Institute (CSI) spec section for fireplaces is Division 10—Specialties (10300 Fireplaces
and Stoves), which would tempt us to choose ¢ ‘Specialty Equipment.” However, your choice of category does impart
certain behaviors to your family. Specialty Equipment is intended more for free-standing equipment items and does
not have a “cut” representation. Items like 10340 Manufactured Exterior Specialties, 10500 Lockers or 10670 Storage
Shelving are all examples of things that would work well in the Specialty Equipment category. Items in Revit that
are “cuttable” interact with the cut plane of floor plan and section views and show bold when cur and lighter when
viewed in projection. Since we will want our fireplace to interact with the wall and appear bolder when cut in plan,
we need a category that supports cutting,

We get this cutting behavior because we chose the “Generic Models” category above. This is sort of a “catch all”
category. You typically choose Generic Models when the item you are modeling does not fit neatly into any of the
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other categories. Generic Models does not impart any specialized parameters that might be available from other more
descriptive categories, but aside from the need for interaction with the cut plane, our existing fireplace has no other

specialized needs. So Generic Model will work OK here.

= In the “Name" dialog, type: Existing Fireplace and then click OK.

You are now in “In-Place family editing” mode. The model will gray ouc but remain visible for reference. The ribbon
tabs will change showing a collection of In-Place family editing tools instead of the usual tools. Take a look at the

Create tab for example(see Figure 4.60).
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FIGURE4.60 The Family Editor mode is enabled when you creawe a new in-place family

The Create tab includes many family editing tools. You can create solid and void forms, insert Components, or add
connectors. Simply click on the other tabs to access these tools as normal. Note that several tools like walls, doors,
and floors are not available in family editing mode. You cannot place (nest) a system family within another family.
Also notice that the “In-Place Editor” panel with its Finish and Cancel buttons appears on the right side of the

ribbon in all tabs.

ADDING REFERENCE PLANES

When you construct complex geomerry, it is often useful to have guidelines ro assist in locating elements. Reference
planes are used for this purpose in families. You sketch a reference plane like the way you sketch walls or lines. You
can snap and constrain other elements to reference planes, making them useful tools for design layourt. You can add
reference planes in any orthographic view of the model. (Reference planes do not show in 3D.) In this example, we
will add them within our In-Place family. When you add them in this way, the reference planes will become part of

the In-Place family and will be visible only when editing the In-Place family.

1. On the Create tab, on the Datum panel, click the Reference Plane tool. (Do
not click Reference Line; make sure you click Reference Plane}.

Click a point inside the large room on the right near the exterior wall, just above the lower window.
2 Move the pointer horizontally to the right past the exterior wall and then click outside.

The exact locations of either click are not critical so long as you draw horizontally and above the window,
A small reference plane (green dashed line with round blue handles at the ends) will appear.

= Edit the Temporary Dimension from the bottom horizontal wall to: 7'-11" [2400] (see the left side of Figure 4.61).
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FIGURE4.61 Creare awo horizontal and twa vertical reference planes 10 frame out ihe fireplace foosprint (dimensions for reference only)
3. On the Modify | Place Reference Plane tab, on the Draw panel click the Pick Lines icon.
= On the Options Bar, in the Offset field, type: 6'-2* [1900].
= Pre-highlight the first reference plane and move the mouse so that the offset line appears above.
4,

Click to create the new reference plane (second panel from the left in Figure 4.61).

Now we'll repeat the process to create two more vertical reference planes. These will frame out the rectangular foot-

print of the fireplace.

5. On the Draw panel, switch back to the Line icon, and then type: 4" [100] in the Offset field.

= Snap to the endpoint of the lower window on the inside edge of the wall.

= Snap to the endpoint of the upper window on the inside edge of the wall (third from the left in Figure 4.61).

TIP: Thestart and end points suggested will make the first reference plane fall to the inside of the house and

the second to the outside. If you click the points in the wrong order, do not cancel, simply tap the spacesar to
flip the line.

6. Switch back to the Pick Lines tool and then change the Offset to: 2'-7" [7 801].

=% Offset the reference plane you just drew to the outside of the house (see the right side of Figure 4.61).

We now have four reference planes that we can use to guide the creation of our fire-place’s form. This is com
g p
practice. Complete details on the use of reference planes in families will be discussed in Chapter 11.

CREATE A SOLID FORM

Using our reference planes as a guide, let’s create the overall mass of the fireplace.
1. On the Create tab, on the Forms panel, click the Extrusion tool (see the top of Figure 4.62).

= On the Options Bar, In the “Depth” field, type: 9'-0" [2750]. (Be sure to
set the Depth and not the Offset—Item 1 in Figure 4.62.)

On the Draw panel, for the sketch shape, click the Rectangle icon (see item 2 in Figure 4.62).

= Snap to the intersection of two of the reference planes and then snap to an opposite
intersection to define the rectangular shape (see items 3 and 4 in Figure 4.62).

= Close all four padiocks (see item 5 in Figure 4.62).
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FIGURE 4.62 Sketch the overall shape of the extrusion

3. On the Modify | Create Extrusion tab, on the Mode panel, click the Finish
button (large green checkmark) (see item & in Figure 4.62).

This gives us our basic fireplace mass. We now need to carve our the firebox.

CREATE A VOID FORM

Using the same basic process, we can create a Void form that will carve away from the solid form in our family giving

us the ﬁrebox opening‘
1. 0On the Create tab, click the Void Forms drop down button and then choose: Void Extrusion.
The Modify | Create Void Extrusion tab will appearwith the same Sketch tools as before.
= On the Options Bar, in the “Depth” field type: 4'-0"{1200].

On the Draw panel, click the Pick Lines icon.

= Click the left vertical edge of the solid extrusion (see panel 1 in Figure 4.63).
A magenta sketch line will appear directly on top of this edge.
On the Options Bar, change the Offset value to: 1'-0" {300).

= Highlight the right edge of the solid extrusion and move the mouse slightly until the dashed line is within
the fireplace structure. When it is, click to create a ragenta sketch fine (see panei 2 in Figure 4.63).

Change the Offset value to: 0 (zero).
= On the Draw panel, click the Line icon.

Using the temporary dimensions as a guide, click the first point on the left edge a bit down from
the top corner and draw it down and to the right at a 20° angle (see panel 3 in Figure 4.63).

= Click the Modify tool or press the esc key twice.
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FIGURE4.63 Sketch lines 1o forms the firebox shape
6. Select the 20° line and then on the Modify | Greate Void Extrusion tab, click the Mirror Draw Axis tool (or press DM).
= Click the midpoint of the vertical sketch line already drawn {see panel 4 in Figure 4.63).

= Move the mouse herizontally and click the finish the mirror line (see panel 5 in Figure 4.63).

"The result is shown in panel 6. Now we will use the Trim/Extend to Corner tool (the same one we used for walls at
the start of the chapter) to clean up the sketch.

7. On the Modify tab, click the Trim/Extend to Corner tool (or Type TR).

= Trim all four corners to make an enclosed shape (see Figure 4.64).

Click the Modify tool or press the esc key to finish trimming.
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FIGURE 4.64 Edir the sketch lines 1o fnalize the shape

9. On the Mode panel, click the Finish Edit Mode button.

While the void is sill selected, it will appear solid. However, w

hen you deselect, it will cut away from the previously
drawn solid to form the fireplace shape.

10. Click in empty space to deselect the element.

11.  Onthe In-Place Editor panel, click the Finish Mode! button {big green checkmark).
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This completes the editing of our family and returns us to the project editor mode.

JOIN THE FIREPLACE WITH THE WALL

The Fireplace family is finished but it overlaps the wall. Let’s fix this.
1. On the Modify tab, click the Split tool (or type SL).
= On the Options Bar, place a checkmark in the “Delete Inner Segment” check box.

2. Split the exterior vertical wall on both sides of the fireplace (see Figure 4.65).
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FIGURE 4.65 Split the exterior wall

3. Click the Modify tool or press the esc key twice.

This is close to what we want but lef’s make one more edit.
4, On the Modify tab, on the Geometry panel, click the Join tool (see the top of Figure 4.65).

= Click one of the exterior walls (the ones we just split).

= Then click the Fireplace to join them (see Figure 4.66).

Remember to watch the Status Bar for detailed prompts.

5. Repeat for the other wall. Pick the wall then the fireplace.

Second pick | Result | Repeat

First pick

3&

FIGURE 4.66 Use Join Geometry to join the walls to the Fireplace

e The Aubin Academy
Copyright (c) 2020 Paul F. Aubin, All rights reserved




Creating a Building Layour | 143

6. Click the Modify tool or press the esc key twice to cancel the Join command.

7. On the QAT, click the Default 3D view icon.

= Use the techniques covered above and orbit the model around so that you can see the Fireplace.

We modeled the fireplace a bit too short. However, for now we will leave this alone. In later chapters we will address
the height of the fireplace as well as how it changes width on the second floor. The fireplace could also use a mantel
and a hearth. However, because there will be no new work done in the living room of this project and therefore no
sections or elevations are needed of the fireplace, that extra level of derail is unnecessary for this tutorial. What we
have created works well for the floor plan. If you wish to try it anyway for the practice, feel free. Select the fireplace,
and then on the Modify | Generic Models tab, click the Edit In-Place button. This will recurn you to the in-place
family editor where you can add these accoutrements using additional solids.

RESET THE CURRENT PHASE

Congratulations! Our work on residential project first floor existing conditions layout is complete for now (see Figure
4.67). We still need to add the Stairs to this model. However, Stairs will be covered in a dedicated chapter. Therefore,
we will save our layout without the Stairs for now.

FIGURE 4.67 The final first floor existing conditions layout
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